
  

  

  

  

  

  

������������������		��  ��		

��������

����		��  ������

����  		����������  

����������  ������		����������		����  

 

 
���������� 	�� 	�
��	��� 
����	�� 
���
���
��  �������  ���	
��	�� 
	���
���  ��������  �����
�� 

 

 
��

��������		��  ��������������  

 
 

���������: 	
��
���
�� �������, ������
��
� ����� 
 
���������: �
��
���
�� ������
� 
 

 
 

© 

2013 



 

 i 

�
��������� 
  

� ������
� ������� ���� �������
�
����
� 
��� ��  
����� ��� ��
 !���� ���
��
��
�� 

�
� !���
�
��

" �
���#����

" �#�"���
� $�����, %���������
� &����� ��' ��� 

������(� �
� ���

��
� $������� 
. ������
� �
��
���
� �
� 
�
�
 ���
��� �� 

����������
��� ����� ��� ��� �
�"���� �
����� �
� 
�� ��� �(
�� ���������� �
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������� 

)���
�����
 ��� ���
"��� ������
�� �������� ����� � ���#���� 
�� � 
����
��� ��'� 

(� ��

" ��������
� �����
� 
�����
" ��'��
� ��� �� �"����� ��� �����
�� ���"����� ��'�  

���
���

" 
������� �����
"� ��"���
�. !
 ������ �"����� �����
� 
�����
" ��'��
� 

��
�������� ��' �
� 
������� (�����'���
 �"�����), �
 ���
 '����
 (���������� �������� 

�����
�� ���"�����), �
 ����
' ��
����
 �����
� (��������� ���"
�), 
�� ��� 
���� ����
��� 

#�#
����� �
� ��
������ 
�� �
� (� ��
' ����
��. 

� 
���� ����
��� #�#
����� ���#���
� �� ���
��
��
' ��
�
����� 
�� � #��������� 

�
� ��������
� �����
� ��
�
������ ���� �
� �
�����

" Matlab/Simulink. 

!
 ���#������ (� ��
' �"����� �����
� 
�����
" ��'��
� ����
����*���� ��' 

�(��� ��
���������
'���� ��� 
 
�������� ���� ���
� �� #����'���� �� �

�
������ 

#�� 
�� “��
 ��” ���"�����.  
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ABSTRACT 

The subject of the present thesis is the design and implementation of a closed-loop 

digital control system for the rotational speed adjustment of a D.C. motor. The complete 

control system consists of the motor (controlled system), the sensor (optical-based  

tachometer), the actuator (power amplifier) and the data acquisition card connected to the 

computer for digital control implementation purposes, programmed via Matlab/Simulink. 

The designed/implemented digital control system, is characterized by high efficiency as 

the motor may now follow any speed profile with considerably small error in both the transient 

and steady state responses. 
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	������� 1 

�������� 

         	��� ���
"�� ������� ������� ���� ����
����� � #��#�
���� ���#����
" 
�� 


����
���� ��'� (� ��

" ��������
� �����
� ��� �� �"����� ��� �����
�� ���"����� 

��'� ���
���

" 
������� �����
"� ��"���
� (D.C.) �� �� ����� ���
��
��

" ��
�
�����. 

 

1.1 �����	� �
������� ������
  [1] 

         , ���'���
� �����
� ����� ��' ��� �������
'����� �������
��
�� ����
��� ���� ����� 

���. )��' ��������� #�'�� 
� ���
������
� ���#�
���� ����� �� '��� ���#'� ��� 

��������'����� ����
�
����. 

         � ������ ���
���
� �����
� �����"���
� 
����� �� 20 ��������� ��'��� �'�� ��� 

������� �6���6�� ��� (� ��
�� ��
�
������. %�������, �
 �#������� �����' �
�� 
'��
� 

�����"�� �� ����� �
�� ��
� �����
 �
�"��

�� ���������� 
�� #���������. 

         !� (� ��
� ��������� �����
� (digital control systems), � ��������� �����'���� �� 

��
�
����� (computer-controlled systems), ����� � �������
��
� ����
�� �
� �

�' ���� ��� 

������6� ���'#�� ���#����
" ���������� �����
� ��������� �� (� ��
' ��
�
�����. ,� 

���
#
� ���
� ��
�� � ���
���� �� ������ �������� �� �
���� ���
��
�� � ���
���. ��� 

����#�����:  

� 7����
 �����, ���"����� 
�� �����������, 

� 7����
 ���
���
�� �����, ����

������, ������ 
�� �������, 

� 7����
 ��
���������� ��������� ���
���
�� ���������, 

� )��
�
��
� ��
�������, �
��
��
�, ���
#�������
� ����
�
���, ��
����
�
���, 

         �����
�, 
��.    
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1.2 
�������� �
�������� ������
 [1] 

 	�
 	���� 1.1 ���
����*���� ��� 
�����
' �"����� ���
���
� �����
� �� �� �
� � 

#
��

" #���������
�. � ����
� ����
����� �
� ����� � �6��: 	�'�
� �
� ��������
� 


�����
" ��'��
�, ����� � �6
#
� �� �

�
���� '�
 ��
 ����� ��� ���
#
 ��� 
��� 

(reference input). 	��� �#���
� ���������, � �6
#
� �����*���� �� ��� ���
#
 ��� 
���. � 

���#���� (feedback), ��
����� 
�������
� �
 ���������
 '����
, �

�'� �
� 
�
�
� ����� � 

“�������” ��� �6'#
�. � #�� 
�� ����6" ��� ���'#
� ��� 
��� 
�� ��� ����
"����� 

�6'#
� ��
����� �
 � ���� (error) �
 
�
�
 ���6����*���� 
 ����
��� [
���������� 

(controller)]. 5���� �
� �'�
� �����
� �
� �
�������� ��' �
� ����
��, ��������� �
 

�����
"���
 ���� �
� �� 
#������ ��� ��
�������� ��
� ��� ��������� �6
#
. %
���� 

 
���, ����6" �
� 
��������� 
�� ���  �����'����� ��
���������, ������������� �
 ����
' 

��
����
 �����
�. )��' #���
� ���� 
�������� (� '�
� ����������) ��� �6
#
 �
� 


��������� 
�� ��� 
������ �
��� �� “
#������” ��� ��
��������. � #�������� ����
��*�� 

�
�� �����
"� �����
���� (������� ��-��������
��), �
� ���
���
�� ��� ��'
���� ��� 

��
���������. 	�'�
� �
� ��������
� 
�����
" ��'��
� ����� 
�� � �������
�
���� ��� 

���#�����  ��� #���������.  

 

����� 1.1: ����	�� 
��
��� ��
����� ���
���. 

 

	�
� ����
��
' ���'���
 �����
 �
 �"����� ������� ���� (��������
�) ��' 

#�� 
��
�� �6������� �� ��������
�� ����������. ��� ��� ������� �
� ������
�
������ 
 

�������������'� Laplace 
 
�
�
� ���������� ��� #�� 
��
�� �6������� ��������
�� 

���������� �� �������
�� �6������� ����#�
�� ����������, #�'�� ���� ���
�
������ � 

��������
� �������.  	��� ��������� ����
��

" ��������
� �����
� 
�����
" ��'��
�, 
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�
 	���� 1.1 ������� ��� �
� � �
� 	�����
� 1.2, '�
� '�� �� ������ 
�� ��
��������� 

������� 
���� ��' �
�� ������
��
�� �������������
"� Laplace. 

 

����� 1.2: �����
��� (���
���� ������) ����	�� 
��
��� ��
����� ���
���. 

   

� R(s) 
 ���/�
� Laplace ��� ���'#
� ��� 
��� (Reference) 

� E(s) 
 ���/�
� Laplace �
� � �����
�  (Error) 

� GC(s) � ��������� ���� 
��� �
� 
��������� (Controller) 

� GP(s) � ��������� ���� 
��� ��� ��
��������� (Plant) 

	�� (� ��
� (#��
����) ��������� �����
�, �
 �"����� ������� ���� (��������
�) 

��' �6������� #�� 
��� �� ��������
�� ����������. ��� ��� ������� �
� ������
�
������ 


 �������������'� 8���, 
 
�
�
� ���������� ��� �6������� #�� 
��� ��������
�� 

���������� �� �������
�� �6������� ����#�
�� ����������, #�'�� ���� ���
�
������ � 

��������
� �������. 

	��� ��������� (� ��

" ��������
� �����
� 
�����
" ��'��
� ((� ��
'� 

���'���
� �����
�), �
 	���� 1.1 ������� ��� �
� � �
� 	�����
� 1.3, '�
� '�� �� ������ 

������� 
���� ��' �
�� ������
��
�� �������������
"� Laplace 
�� 8���. 
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����� 1.3: �	����� (��������� ������) ����	�� 
��
��� ��
����� ���
���. 

 

�  R(z) 
 ���/�
� 8��� ��� ���'#
� ��� 
���, 

� GC(z) � ��������� ���� 
��� �
� 
���������, 

� GP(s) � ��������� ���� 
��� ��� ��
��������� (�����'���
 �"�����), 

� D/A ������
���� (� ��

" �� ����
��
' ���� (Digital to Analog converter), 

� A/D ������
���� ����
��

" �� (� ��
' ���� (Analog to Digital converter)  

!
 ��
����
 D/A ���������� �� #��
���� ((� ��
�) �6
#
 �
� (� ��

" ����
�� �� 

���� �����
"� ��'�
�, 
�������
� ��� ��� “
#�����” ��� ��
���������. !
 ��
����
 A/D 

����� ���������
 ��� �� �������(�� ��� ����
��
� �6
#
 �����
"� ��'�
� ��� 

��
��������� �� ���� #��
���
" ��'�
�, 
�������
� ��� ��� ��
 
#'���� �
� ��
� 

(� ��
' 
���������. 

 

1.3 ����	������ ��� �������� 

	

�'� ��� �������� �����  � 
����
��� ��'� (� ��

" ��������
� �����
� 
�����
" 

��'��
� ��� �
� �����
 ��� �����
�� ���"����� ��'� ���
���

" 
������� �����
"� 

��"���
�. , �����
� �
� 
������� ��
�
������ ���� ���� 
����� ����
��� #�#
����� [Data 

Acquisition Card (DAQ)], ��
���������� �� ���
��
��
' /�
�
����� (H/Y). � 

���

������ ��� 
����� DAQ �� �
� �// ������������� ���� �
� �
�����

" MATLAB 
�� 

�
� ��
��
� �6
�
����� Simulink. ��� ��� ������� ��� �����
�� ���"����� �
� 
������� 


����
������
� ���
 '����
 �
 
�
�
 ���������� �� ����'���� �������
 �� �
� 
������� 
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�� ����
��
� ����, �
� ��� �������� 
#������� ���� ����
��
� ���
#
 ��� 
����� 

����
��� #�#
����� (DAQ card).  

 

1.4 ������ ��� �������� 

 , ��'�
� ��� �������� ����� �
���#����
'� 
�� ���������� ���� ��

�'���� 


����'��� ��� ����
�� ����� ��� ���������� �����
� 
�� ��#�
'���� ��� (� ��
�� 

���������� ���
���
� �����
� 
�����
" ��'��
�, �
� ��
�
����' 
�� ��� �
�
������ �
� 


�������
� 
��������� �� ��� �"����� ���
���
� �����
� 
�����
" ��'��
� 
�� ��� 

������� 
�� �"�
���� ��� ������� 
��� ��� �6'#
� �
� �� ��� � ���
�� #�� 
����
�� 

���'#�� ��� 
���.  
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	������� 2 


�������� 	�� ����
�� ��� ����	�� ���������  

��
 �
�������� 

 

2.1   �������� 

	�
 
� ����
 ���' ������� 
���� �������
� '�� �� ���� �
� ������
�� �
 .� ��
' 

	"����� )��
���
� �����
� $�����
" 5�'��
� (	.).�.$.5.). 

 

2.2   	�������� D.C. 

, 
�������� �
� ��������
� ��� ��� ��
�
���� �
� .� ��

" 	�������
�  

)��
���
� �����
� $�����
" 5�'��
� ����� ���� 
�������� �����
"� ��"���
� D.C. ��� 

�������� BOSCH �� ����
�������
� ����
������ (12V DC/1.3)mp). � ��
������ �
� ����� 

��' ���
��
�
���
 ���

������ 
�� ��
����� �
� 
������� �������
 �� �
� ���������� 

�
� 
�
�����
� ("6�� �
� ���

����
�. 

	��� ��������, �� ��� �����
�����
 #���
� ���
� ���� 
�������
� ��
�������
� 

#��

� #������
� 8 cm �����
� �
�  ���� 40 
��� ���� ���� ����� �
�, 
 
�
�
� 

��
����'���
� 
�� ��������
� 
�������� �� 2 ��#�� �"�
� allen ���� ��
� �6
�� �
� 


�������. 

, �������
'� #��

� �� ���#����' �� �
� 
��
*�"
�� 
�� �
 ���
 '����
 �
� 

������� ���� ����
���, 
��������� #����� ��� �
���� ������� ��� �����
�� ���"����� 

�
� 
�������. � �����6� �
� 
������� 
�� �
� 
��
*�"
�� �����"��� �� 3 �������

"� 

���#���
�� ���� �� 
�������� #���
� ����� ��������� ���� 
����
�������� ��' 

������������ ��������. 

	�
 	���� 2.2 ����

��*���� 
 
�������� �
�
�������
� ���� ���� ���� �����6��, 
 

#������
� #��

� ���������
� ��� �
� �6
�� �
� 
������� 
�� 
 
��
*�"
���. 
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	���� 2.1: $��
(� �
� 
������� 
�� ��� ����� �����6��. 

 

 

	���� 2.2: 3������
� #��

� 
�� ���������
 �������� �����
�� ���"�����. 
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2.3   ����������� 

��� ��� �
���� ������� ��� ���"����� �
� 
�������, ������
�
����
� ��� 

���������
 �
 
�
�
 ������� ���������
' ����' �� ����'���� ����
�� ��� �����
�� 

���"�����. 	��� ��������, 
 �����'���
� ���������
'� ����'� 
#������� �� ���� 

������
��� ����'����� �� ����.     

 

2.3.1 ���������� �������� �����	�� ���
�����  

��� ��� ������� ��� �����
�� ���"����� �
� 
�������, ������
�
����
� �
 

���������
 �,)2001 ��� �������� Honeywell �
 
�
�
 ����� ���� 
��
*�"
��� ����"����. 

!� #"
 ����
� ���� �
� ����� �
 LED �
�
���� �������
�  ��'� (IR Led) 
�� �
 
"
���� 

�
� #�
�� �
� ��
�������� ��' ��  ��
#�
#
, �
� ��������, �
 ������
�
���� �����, ��� 

�"�� Schmitt trigger � 
�
�� ������� ���������
' ����' ���� �6
#
 
�� �
 NPN 

����*���
� �6'#
�.  

	�� ��������, �
 ���������
 ��������
� 
�������� ������� ��
� �������
' #��

 

�
� 
�������, �� ��'�
 ���� '��� 
��� ��� �������
 � �
� #��

� ����6" �
� IR LED 
�� 

���  ��
#�'#
� ������� 
��, #���#� 
���
� ��� �, �'�� ���� �6
#
 ��������� �
��
' “1”. 

0� ���'� �
� ��'�
 ���� �6
#
 �
� 
��
*�"
�� ��������� ��� ������� ���� �� �
� � 

���������

" ����
", � ����'���� ��� 
�
��� ����� ����
�� ��� �����
�� ���"����� �
� 


�������. 

� ��
 
#
��� �
� ���������
� ������� �� ������
�
������ ���� 5 Volt �
� 

��������� ��' �
 
"
���� �
� ������
��� ����'����� �� ���� (������� ���� ��� 

��������), ��� ��� �
� ����
����' �
� ��"���
� ��
 
#
���� �
� IR LED ���� �
�
������� 

��� ��������� 330 - �� ����� �� ��� ���� ��
 
#
����. 

)

�
��
"� �
 �������
' �������
' #�������� (	���� 2.3), �
 #�������� 

�
�
#�
��� (	���� 2.4) 
�� �� ����
� ����
�������
� �
� ���������
� HOA2001, 

%���
�� 2.1 [2]. 
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	���� 2.3: 	������
' #�������� �
� ��
����
� HOA2001. 

 

 

 

	���� 2.4: 3�������� �
�
#�
��� HOA2001. 

 

 
   

 
 
 
 
 
 
 
 
 
 
 



$��)+)�, 2 
 

 10 

%���
�� 2.1: 5���
� ����
�������
� �
� ��
����
� �,)2001. 
 

 
 

 
 
2.3.2 �������
��� �
�������� �� ����  

 !
 ���������
 �������� �����
�� ���"����� (HOA2001) ��*� �� �
� ������
��� 

����'����� �� ����, ������
"� �
 ��
����
  ���#����� �
� (� ��

" 	.).�.$.5.  	

�' 

���� �� ������
�� ��� ����'����� �
� ��������� ��' �
 ���������
, �� ��� ���� DC 

����
�� ��� �����
�� ���"����� �
� 
�������. 	�� ��������, ���� � ���� 
#������� �� ��� 

����
��
� ���
#
 ��� 
����� ����
��� #�#
����� 
�� ���� ��� �
�����
�� MATLAB 
�� 

Simulink, ������������ 
�������� �� �����
� ���"���� (�). 

 � ��
�
���� �
� ������
��� ����*���� ��
 
�

�������
 LM 2917N ��� �������� 

National, �
 
�
�
 ����� ���� ������
'� ������
���� ����'����� �� ����, ��� ���� �6
#' 

�
� ���� ��
������ ���  ����
 �"�
� Butterworth 2 �'��� ��� �
� ����
����' ��� 


�������� ��� DC �����. � ������
'���� �
� ���
�
�����
� �����
��� ����� ±0.3%. � 

����� �
� 
��
��*�� ��� ���� �6'#
� �� ��������� �� �� ����'���� ���'#
� �����:  

   11 CRVFV psupinout ���� �   (1)                                                            
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'�
� Vout � ���� �6'#
� �
� ������
���, Fin � ����'���� ���'#
� �
� 
�� Vsupp �  ���� 

��
 
#
���� �
�. ����#� � ���� �6'#
� �6������� ����� ��' ��� ���� ��
 
#
����, ���� 

������
�
����� ����� LM7812 ������������� ���� ��
 
#
��� �
� 
�

�������
� 

LM2917 ��  ��'�
 � ���� ��
 
#
���� Vsupp �� ��������� ������
�
������ ��� 12Volts 

���6������� ��� ����� Vcc �
� � ���'*���� ���� ���
#
 �
� ������
���. ������
� ��
 


"
���� ���� ��
������ 
�� ���� ������
�
����� ����� LM7805, 
 
�
�
� ��
 
#
��� �� 

������
�
������ ���� 5 Volts �
 ���������
 �������� �����
�� ���"�����. 	�
 	���� 2.5 

���
����*���� �
 �������
' �
� 
�
�����
� 
���� 
�� �
 �������
 ��� ���
���� ����� 

(	���� 2.6) ���� 
�� �� �� �6�������� (	���� 2.7). 

 

	���� 2.5: 	������
' #�������� 
�
�����
� ������
��� ����'����� �� ����. 
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	���� 2.6: !������
 ���
���� ������
��� ����'����� �� ���� ����� �� �6��������. 
 

 

 
 

	���� 2.7: !������
 ���
���� ������
��� ����'����� �� ���� �� �
�
�������� ��   
�6��������. 
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!
 ���
��
��
' 
"
���� �
�
������
� �� 
�����' 

���, ��
 ����'� ���
� �
� 


�
�
� (	���� 2.8) #��
������� 
 �
�
#�
��� ��� ����� �6'#
� BNC 
�� �
 ��#��
��
' led 

����
������. � ���� ��
 
#
���� �
� ������
��� ����� 14-18Volt DC (�"�
� “�������”). 

	�
 ���� ���
� �
� 

���
" (	���� 2.9) �������
"���� 
� ��'���� ��
 
#
���� �
� 

������
��� (Vcc), 
 �
�
#�
��� ��
 
#
���� �
� 
��
*�"
�� (Vcc opto) 
�� 
 �
�
#�
��� 

�"�
� BNC ��� ����'����� ���'#
�. 

 

 
 

	���� 2.8: ����'� '(� �
� ������
��� ����'����� �� ����. 
 
 

 
 

	���� 2.9: %��� '(� �
� ������
��� ����'����� �� ����. 
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2.3.3 

��������� ��� �����	�� ���
����� ��
 	�������  
 

9��� ��� ����
� ��������, 
 ������
���� ���������� �� ����'���� �
� �������� 

��' �
 ���������
 �������� �����
�� ���"����� �� ������ ����, � 
�
�� ����� ����
�� ��� 

���"����� �������
 �� �
� 
�������. 	�� ��������, ���� � ���� DC ��������� �� 

����
��
� ���
#
 ��� 
����� ����
��� #�#
����� (DAQ) 
�� ������������ �� �����
� 

���"���� (rad/sec) ������
�
������ 
�������� �6����� � 
�
�� ���
����*���� ����
���.  

�����*
���� '�� � DC ���� �6'#
� �
� ������
��� ����� ������
� ��������� ��� 

����'����� �
� ���������� ���� ���
#
 ��' �
 ���������
 �������� �����
�� ���"�����, 

��� �� ��
�
������ � ����� �� ��� 
�
�� ������������ � ���� �6'#
� �
� ������
��� �� 

�����
� ���"����, ����
� #��
���� ���� ���
#
 �
� ������
��� ���� ���� ���������� 

����
����� #�� 
����
�� ����� ����'����� ���������
�� �
� �� 
�� 
���  
�� 


������ ���� � ���� �6'#
�. !
�
�������� �� *�"�� ����� �
� 
������ ���� ��
 

�
�����
' MS Excel, ��
�
��*���� (�� �� ���
#
 ��� ��������� ����������) � �6����� ��� 

������� ��� ����� �6'#
� �
� ������
��� 
�� ��� �����
�� ���"����� �
� 
������� 

(%���
�� 2.2). 
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%���
�� 2.2: � �6����� ��� ������� �� ��� ���
#
 ��������� ����������. 

 

 

 

	�
 ��#�
 � ���
����*
���� 
� ����� ��� ����'����� �
� ���������� ��
� 

������
���, ��� ��
 ��#�
 � ���
����*
���� 
� ����� ��� ����� �6'#
� ��� 
��� ��� ��' ��� 

����������� ����'�����. 

	�
 ��#�
 C ���
����*���� � �����
� ���"���� (�) �
� 
������� ��� 
��� ��� 

����'����. �����*
���� '�� 
 #��

� �
� ��
����'���
� ��
� 
������� #������� 40 
���, � 

�����
� ���"���� ��
�
��*���� ��' �
� �"�
:  

   
40

2 �
�

��
�

f
 (rad/sec)  (2)   

'�
�  f  � ����'���� ���'#
� ��
� ������
���. 
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	�� ��������, �� ��� ���
#
 ��������� ����������, ��
�
�����
� � �6����� ��� 

������� �
� 
��
��*�� ��� �����
� ���"���� �
� 
������� ���������� ��� ����� �6'#
� �
� 

������
���:  

    �=64.5650·V-2.5923 (3) 

 

 

2.4  �����
��� (����	� �������� ������
) 
 

, ��������� ����� �
 ����
' ��
����
 �����
�, �� �

�' �� #���
� ���� 
�������� 

��� �6
#
 ��� 
����� ����
��� #�#
����� ���� �� ��
����� �� “
#������” ��� 

��
��������, #���#� �
� 
�������. 	��� 
���� ��'
����� ��� ���� �������� ��"���
� 

�����
���� ��� ���������� ���" ��� �� ����
������� 
 
��������. !
 
"
���� �
� �������� 

��
�������� ��' �
 
�

�������
 �� 
�#�
' LM675 ��� �������� National �� 
��� 
� TO-

220, ��'
����� #� ��� �������
' �������� ���"
�, ��
�
�����
 �� ���#���
�
��� �� 

������� �� �������� �
��#���
� 
��#
�� (Non-Inverting unity gain operation). 

��� ��� ��
 
#
��� �
� 
�
�����
� ����������  ��������
� ���� 16-30 Volt ��� 

����� �
��'� �� 
#������ �������
� 
�� ������
�   
����  �� ������
 ��"�� �6'#
� 3Amp.  

!
 
��#
� ��� ��������� ���� ���
"�� � ���
�� ��
"��� �� 1 (�v(DC)=1), #���#� � ���� 

�6'#
� ��
"��� �� ��� ���� ���'#
� (Vout=Vin) ��
�� � #�"���� �� ��� 6�������� ��� ���� 

��
 
#
���� �
� ��������. 

, ���
�
�����
� ��������� #������� ��
������ ��� �6'#
� �
� ��' ��� ������ ����� 

'��� 
#���� �������
�  
���� (�� DC 
��������), 
�� ��’ ���' #�� ������� ����
� 

�
�
������� flyback #�'#�� ����6" ��
 
#
���� 
�� �6'#
�. ������, 
 LM675T #������� 

��
������ ��' ������������, �� ��
������� �� #��
'���� ����� ��� ����
����� �
� '��� 

� ����

����� ��
 
��� 
� 6�������� �
�� 170 °C. 

� 
��������� ���"
� �� �� �
� � ����'����� ��
�
��*���� ��' �� �����: 

  
Q

L

s
)MAX(D P

R

V
P �

��
�

22

2

�
 (4) 

'�
� VS ���
��
� ���� ��
 
#
���� �
� LM675T, RL � ���������  
���
� 
�� PQ � 


��������� ���"
�  �����  
���
. 

��� �� ����� ("6� �
� �������� ���� �
�
������� (�
��� ��
�����
� �"�
� U � 
�
�� 

���� ��
�
����� ���
���
� �� �
 ��'�
��
 
"
���� �
�
�������� ��#������ �
����
' 

 "��
 (���
�) ��*� �� ����
������� �����, ��� ��� 
��"���� ��
���������
'���� 
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��������� ��*� �� ��� (�
��� ��
�� �
�
������� �6�����
� �
� 

���
". ��� ��� ����
�� �
� 

���������
� .� ��
�� 	��������� �����
�, 
����
������
�� #�
 '�
��  
�
������    

��������, �� 
�
�� �
�
������
�� ��
 �#�
 

��� �� 

��� ��
 
#
���, 
�� ���6�����
 

#��
'��� on/off, ���� ���� �� ������� � #����'���� ��� ����'��
�� 
#����� #"
  
�����. 

	��� �������� �

�
��
"� �
 #�������� �
�
#�
��� �
� LM675T (	���� 2.10), �
 

�������
' #�������� ��� ���
���� �
� �������� (	���� 2.11), 
���� 
�� �
 PCB ����� 

�6�������� (	���� 2.12) 
�� �� �� �6�������� (	���� 2.13), [3]. 

 

 

	���� 2.10: 3�������� �
�
#�
��� �
� �������� LM675T. 
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	���� 2.11: 	������
' #�������� 
�
�����
� ��������. 
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	���� 2.12: !������
 ���
���� �������� ����� �6��������. 

 

 

 

	���� 2.13: !������
 ���
���� �������� �� �� �6��������.
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	��� ����'� ������ �
� �������� (��
'�� 2.14) ��
�� �
�
������� ���#����� �����
� 

���'#
� �"�
� BNC (Vin) 
�� ��'���� �6'#
� (OUTPUT) ���6������� ��� 
��� 
"
���� 


���� 
�� �� ��#��
��
� led (
'

��
) ��� �� ����
� 
�� (������
) ��� ��� ������
� ���� 

��
 
#
����. � �����
�
���� 
�� �������
�
���� �
� 
��� �������� ������� �� ��� 

#��
'��� 4 ��� ��. 	��� ���� '(� (��
'�� 2.15) #��
���
���� �� 2 
�

�������� 


�
������ LM675T  �� ��� (�
���� �
�� 
�� ��� ��'���� ��
 
#
���� (��������
� ���� 

��
 
#
���� ±32 Volts DC). 

 

 

	���� 2.14: ����'� '(� �
� ��������. 
 

 

	���� 2.15: %��� '(� �
� ��������. 
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2.5.  	���� �
������ ��������� (DAQ CARD) [4] 

 
,� 
����� ����
��� #�#
����� (Data Acquisition cards) ����� �
 ���
 #���"�#���� 

����
��
�� ���������� �� �
� ���
��
��
' ��
�
�����. ����� #���
� ������ 
�������� 

���� �� ��
�
"� �� ���#��
"� ���� �� 
��
�� �"�� �
� �// (���������, ������
�, USB, 


.�.), ���� �� 
��
�� ��
#
�� ��� �����
�� 
����� (PCI, ISA, PCI-E, S-100 bus 
.�.). ����#� 


� 
����� ����� ������� ��������
�� ��
��� ��
��������� '��� �
�����
���, 

������
����, ��
������, ����� 
.�., ��
�� �����������
 ���� ��
�
����
��, 
 
�
�
� ���� 


�������
� �
�����

", 
��
��*�� �� ����� ����
������ 
��� �
��#��.    

� 
���� ����
��� #�#
����� �
� ������
�
����
� ���� ������� ���� ��
����� 

����� �
� (� ��

" 	.�.$.5. �
� ����������� �� #��
���
�
��� (� ���'*
���� ��� 

����'���� #������
��(���) ��� ����
��
� ���� �
� ���
 '����
� ��  (� ��
' ����, 
�� 

��� ��������, ���� �
� ��
�
����' �
� � �����
� 
�� �� #�'����� �
� ��' �
� ����
�� 

�
� ��
�
������ ���� Simulink, ������� �� #�
������� ���� ���� ����
��
� ��� �6
#
,  �� 

��� 
�
��  ���� �
� �������� 
#������� 
 
��������. 

!
 �
����
 ��� 
����� �
� ������
�
����
� ����� � PCI-6024E ��� �������� National 

Instruments. � ���
�
������ 
���� #������� 16 ����
��
�� ���'#
�� �� ����' 

#������
��(��� 200 kS/s �������� 12 bit, 2 ����
��
�� �6'#
�� ��� 12 bit, 8 (� ��
�� I/O 


�� 2 �������� ��� 24 bit. %�
 �������
�, �� ����
�������
� ��� 
����� ������������ ��
� 

%���
� �
� �

�
����: 
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%���
�� 2.3: 5���
� ����
�������
� ��� 
����� National Instruments PCI-6024E. [5] 

 

 

 

 

 

 

 

 

 

 

 

� 
���� ����� ������� �� '�� �� ������ ����
����
� ��������� (Windows 

2000/NT/XP, Linux®, Mac OS X), ��� ���

������ �� #�� 
�� ��
�������� ����
��� 
�� 

���6������� #�#
����� '��� LabVIEW, MATLAB (Simulink), LabWindows/CVI, 

Measurement studio, VI Logger. 

� �
�
������ ��� 
����� ������� �� ��� ���"���� �"�� �"�
� PCI �
� �//, ��� �
 

��
��
 ������������ 
�� ��� ���
��� #���"�#���� ���'#�� �6'#�� SCB-68, � 
�
�� 

#���

�"��� �� �"�#��� ��� ���'#��/�6'#�� �
� ��������
�. 	���  ��
��� ��� �
� 

�

�
��
"�, ���
����*���� � ��
�������� ��� 
����� PCI-6024E ��
� �// (	���� 2.16), 

� ���
��� #���"�#���� SCB-68 (	���� 2.17), 
���� 
�� 
 ����
�� ������
������ ��� 

�
�
#�
��� ���  (	���� 2.18). 

 

Family NI 6024E 
Bus PCI, PCMCIA 
Analog Inputs 16 SE/8 DI 
Input Resolution 12 bits 
Max Sampling Rate 200 kS/s 
Input Range ±0.05 to ±10 V 
Analog outputs 2 
Output Resolution 12 bits 
Output Rate 10 kS/s 
Output Range ±10 V 
Digital I/O 8 
Counter/Timers 2, 24-bit 
Triggers Digital 
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	���� 2.16: ��
�������� ��� 
����� PCI-6024E ��
� H/Y. 
 
 

 

	���� 2.17: � ���
��� #���"�#���� SCB-68. 
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	���� 2.18: )�����
����� �
�
#�
��� ���'#
�/�6'#
� ��� 
����� ����
��� #�#
�����. 
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��� ��� ����
�� ��� �������� ������
�
����
� �
 Analog Input Chanel 0 (ACH0) �� 

���
#
� ��� ��� 
������ � ��� ����� �
� ���
 '����
� �
� ������
���� ��
�� �
�
#�
��� 

68+/67- ��� ���
���� #���"�#����, ��� � �6
#
� ��������� ��' �
 Analog Output Chanel 0 

(DAC0OUT) 
�� �
�� �
�
#�
��� 22+/55-, � 
�
�� ��� �������� 
#������� ��
� ��������. 

 H ���

������ ��� 
����� ����
��� #�#
����� �� �
� ��
�
����� ������� �� �
 

�
�����
' MATLAB 
�� ��
 ���
�
������ �� �
 ��
��
 Simulink. %�'
����� ��� 

��'������ �6
�
����� #�����
�� ���������� ��
 
�
�
 �����
�� ��
��� ��
���������� 

#
��
� ��
����� �
� ���

����
"� ����� �� ��� ���'#
��/�6'#
�� ��� 
����� ����
��� 

#�#
�����. 
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	������� 3 

���������� 	�� 
��
����� ��
 �����	�
 

�
�������� ������
 

 

3.1   �������� 

	�
 
� ����
 ���' ���
����*���� ����
����� 
 �������
'� ���#����'� �
� 

(� ��

" ��������
� �����
� ��������� �� ��� ���
��
� ��
�
���� �
�, � ���'*
����  

#�� 
����
�� ���'#
�� ��� 
���, ���������� 
���  
�� ��� ������
��� ��'
���� �
� 


�������. 

 

3.2   ��
����	�� 

��������� ��� �
��������  

��������� ��
 	������� 

 0� ���� ��� ����
 
���� ��� �� ���
���
� 
�� ������
� ��
����� �
� 
�������, � 

��������� ���� 
��� �
� ��
�
��*���� �� �������
' ��'�
. 0� �� ����� �
� Matlab 
�� 

�
� Simulink, 
������ ���� � ��'
���� (�����
� ���"����) �
� 
������� '��� ���� ���
#
 

�
� � ���'*���� ��� ������� DC ����. 	�� ��������, �� ���� �
 #�������� �����
�� 

���"����� ��
�
��*���� � ��������� ���� 
��� �
� 
�������. � #��#�
���� �
� 

�

�
������� ����� � �6��:  

1)  �
���
"���� 
� ����������� ���#�����, ��
�: ��
 
#
��� DC 14-18 Volts ��
�� 

�
�
#�
��� ��
 
#
���� Vcc �
� ���
 '����
�, � �6
#
� �
� 
��
*�"
�� ��
 Fin �
� 

���
 '����
�, � �6
#
� �
� ���
 '����
� ��
 ACH0 ��� 
����� ����
��� 

#�#
����� (�
�
#�
��� 67--AIGND, �
�
#�
��� 68+-ACH0), 	������ 3.1 
�� 3.2. 
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	���� 3.1: 	"�#��� �
� ���
 '����
� �� �
� 
������� 
�� ��� ��
 
#
���. 

 

 

 

	���� 3.2: 	"�#��� �
� ���
 '����
� �� ��� 
���� ����
��� #�#
�����. 
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2)  	�
� �// �� �
 ��'������ Matlab ���������� �
 ��

��#�
 Simulink 
�� ��� 

�������� ��' �
 File -> ,pen ���������� �
 �����
 “open_loop.mdl” (��'
����� ��� 


�������� ����������
 �
����
 
������ �� ��� �����
�� ���"����� �
� 


�������). 

 

 

	�
 �
����
 �
� ���
����*����, �
 “)nalog input” ������
���� ���� ����
��
� 

���
#
 (Channel 0) ��� 
����� ���� 
�
�� 
������ ���� � ���� �6'#
� �
� 

���
 
����
�, �
� ������������ �� �����
� ���"���� �"� ��� �� �� �����:  

�=64.5650·V-2.5924 

'��� ���� ��
�
�����
� ���� %������ 
 2.3.3. 	������: 

K (gain)=64.5650  C (constant)= 2.5924 

	�� �������� ���������� (��' �
 menu) “�ools ->Reatime Workshop -> Build model”  

���� �� ��
�
����� �
 �
����
 ���� 
���� ����
��� #�#
�����. 
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!��
�, ���������� (��' �
 menu): “Simulation -> Connect to target” ��� ��� ������6� 

��� ���

������� �
� ��
�������
� �� ��� 
���� ����
��� #�#
�����.  
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3)  �����
�
������ �
 ��
 
#
��
' ����� �� ������� �"�#��� �� �
� 
������� 
�� 

�����*���� � �6
#
� ��� 6 Volst DC. 	�
 �
����
 simulink ����������: “simulation -

> start real -> time code”, ���� �� �

������ � 
������ � 
�� ���#����� 
 


�������� ��
 ��
 
#
��
' (����� 3.3).  
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	���� 3.3 : 	"�#��� �
� 
������� �� ��� ��
 
#
���. 

 

 ) 
" �
�������� �
 ��'������ ��� ����
� #�����'�����, ���� !"#$%�& 
 
�������� 

��' ��� ��
 
#
���, 
�� ���������� “simulation -> stop real ->time code”. 	�
 �������
 

���
��� (command window) �
� Matlab ���������:   

>>plot(t,w),zoom, grid     


�� �� ���*���� �
 #�������� ��'
����� ��� �����
�� ���"����� (rad/sec) �
� 
������� �� 

��������� �� �
 ��'�
 (sec), 	������ 3.4, 3.5:    
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	���� 3.4: )�'
���� 
������� �� ���
#
 �����#� ����
� 6 Volts. 

 

	���� 3.5: )�'
���� 
������� �� ���
#
 �����#� ����
� 6 Volts. 
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 )�' ��� �
� � ��� ��'
����� �
� 
������� �� ���
#
 �����#� ����
� 6 Volts  (	���� 

3.5), ��

"���� '�� � ��������� ���� 
��� ��� �����
�� ���"����� (�6
#
�) �� ��
� ��� 

���� ���'#
� (���
#
�), ��
��� �� ��
��������� (�� ��
#�
�� �
������), �� �"����� 

#�"����� ��6��: 

 � � � �
� �sV

s
sGP

	
� =

� � � �bsas

baK ss

���
��

=
� � basbas

baK ss

�����
��

2
 (5) 

 ��� �
 �"����� ��� �6������ (7) ��
�� ��
����� #"
 ��������

� �'�
�, 
���� ���' 

#�� �� ���*�� ���������
� ������� 
�� ���� ��'
���� �
� (	���� 3.5). )�' �
� 
����' 

��� ���������� ���� 
��� ��

"����: 

 � � � �
� �sV

s
sGp

	
�  => � � � � � �

� � � � sbsas

baK
sVsGs SS

P

6
�

���
��

���	  (6) 

9�
� � ���
#
� (�����#� ����
� 6 Volts) ���� ����
��������� ��' �
 ��
#"���' ��� 

��
 ��#�
 Laplace. � ��'
���� �
� 
������� ��
 ��#�
 �
� ��'�
�, ��

"���� ��' ��� 

�6����� (6) � ���'*
���� �
� �������
 
 �������������' Laplace, ��
� [6, ���.459]: 

 � � 
�

�

�

�
�

�
�

�
�

���
� �� btatss e

ba

a
e

ba

b

ba

baK
t 1

6
�  (7) 

	�� �'���� 
�������� (t=:) � �6����� (7) #����: 

 � � ssK��� 6� => 
� �

2667.24
6

6.145

6
��

�
�
�

ssK  rad/sec (8) 

'�
� � ����
� ���� ��� ��'
����� � ��� = 145.6000 rad/sec ��

"���� ��' �
 	���� 3.5. 

 ,� ��������
� a,b ��� �6������ (7) ��
�
"� �� ��
�#�
����
"� �����
� �"

��, 

����"
���� ��� �6����� (7) 2  
��� (�� �"����� �6�������) ������
�
������ #�#
���� 

��� ��'
����� ��� 2 #�� 
����
�� ��
��
�� �������. %�������, ��' �
 	���� 3.5 ��

"����: 

t1=0.1000 sec                       y1=39.8400 rad/sec 

   t2=0.4000 sec                       y2=135.4000 rad/sec 

	�� �������� #���
�������� �
 ����
��� m-file: 
 

function [F]=get_DC_motor_TF(x) 

 

F=[145.6*(1+x(2)*exp(-x(1)*0.1)/(x(1)-x(2))-x(1)*exp(-x(2)*0.1)/(x(1)-x(2)))- 39.84 

145.6*(1+x(2)*exp(-x(1)*0.4)/(x(1)-x(2))-x(1)*exp(-x(2)*0.4)/(x(1)-x(2)))-135.40]; 

 


�� ���
��
�
������ ��
 Matlab command window: 

>>[x]=fsolve(@get_DC_motor_TF,[5 15]) 
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��

"���� � �"��: 

                                       a= 10.4371                           b=10.4358 

���
�'� �
� ��
#��
�"�� '�� �����'���� �
 �"����� ���� ��� #���' ��������
' �'�
. 	��� 

��������� ����, � ��'
���� ��� �6������ (7) �����������*���� ���� ����
��� ��'
����, 

[6, ���.461]: 

 � � � �atatss atee
a

aK
t

�� ��
��

� 1
6

2

2

�  (9) 

9�
�� �� ��� ��
��
"���� ���������, � ��������
� a ��
��� �� ��
�
������ 

����"
���� ��� �6����� (9). %�������, ��� �
 *�"�
� ����� (t2,y2), #���
�������� �
 m-file: 
 

function [F]=get_DC_motor_TF(x) 

 
F=[145.6*(1-exp(-x(1)*0.4)-x(1)*0.4*exp(-x(1)*0.4))-135.4 ]; 

 


�� ���
��
�
������ ��
 Matlab command window: 

>>[x]=fsolve(@get_DC_motor_TF,[10]) 

��

"���� � �"��: 

a=10.8306 


�'�� � ��������� ���� 
��� �
� 
������� �����: 
 

 � � � �
� � 3019117661221

52992846
2

.s.s

.

sV

s
sGp ��

��
	

 (10) 

 

  
3.3   �������	�� 

��������� ��
 �����	�
 

	���
�
���  ��
 �
�������� [1] 

 ) 
" ��
�
�����
� � ��������� ���� 
��� �
� 
�������, ���� �� ���
����*���� � 

#��#�
���� ��
�
����
" ��� ���������� ���� 
��� �
�  (� ��

" 
��������� GC(z) �
� 

��������
�. 

� ���
#
� �
� ������
�
����
� ��� �
 ���#����' �
� (� ��

" 	.�.$.5 
�
��*���� 

���
#
� �
�
������� ��� �'���, 
 ���#������ #���#� 
��
��*�� �
�� �'�
�� �
� 

���
��

" 	.�.$.5 
�� ��� �������� ��
�
��*���� 
���������� �
� �� ������ �� 

������
�
�����. 
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7��� �"����� �����
� 
�����
" ��'��
� �� �
� 
��������� �� ����� �� ��� 

��
�������� ��
� ��� 
��#
 
�� �
��#���� ������
� ���#���� (	���� 3.9).    

 

	���� 3.9 : $�����
' 	.�.$.5 �� �
� 
��������� ��
� ��� 
��#
 
�� �� ����� �� ��� 

��
�������� (��'�� ������������). 

 

� ���
��
� ��������� ���� 
��� �
� 	.�.$.5  �
� 	�����
� 3.9 �����:  

 � � � � � �
� � � �s.GsC+ 1

sGsG
sH

pc

pc �
�  => � � � � � �

� � � �z.GzC+ 1

 zGzG
zH

pc

pc �
�  (11) 

����"
���� ��� �������� �6����� �� ��
� Gc(z) ��

"����: 

 � � � �� � � � � � � �zGzGzHzGzG pcpc �����1  => � � � �
� � � � � �zHzG-zG

  zH
zG

pp

c �
�             (12) 

 7��� � ����
��
� ������������: 

� �
z

z

p
dP

nP
zG �        � �

z

z

dH

nH
zH �  

)���
���������� ��� �
�'����� ����� ��
 �������' ���
�  ��� ���������� ���� 
��� ��� 

�6������ (12), ��

"����:  

 � �
� �nHdHnP

dPnH
zGc ��

�
�  (13) 

 

)���
�, 
 ���#����'� ��
�
������ ��
 ������ ��'�
. /�
���
���� 	.�.$.5. #�"����� 

��6��, �����
� ����
�
, �������� 
�� �� ���� ����"(���, ��' �� ������ ����� �����' '�� 

���' ������ �� ���� 2 ��*����� ����#�

"� �'�
�� �� ������
' ��������
' ���
�, #���#� �� 

����

���� ��
 �������' ����#�
' ��������#
. 

������
���� �� �'�
� 
� p1 = -2+2j 
�� p2= -2-2j �
� '���  ������� ��
 	���� 3.10 

����

���� ��
 �������' ����#�
' ��������#
 
�� ����
����*
���� ��' �'�
 ��'������  

�=cos(�)=cos(45o)=0.707.   
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	���� 3.10 : !
�
������ ��� �'��� �
� 	.�.$.5. ��
 ����#�
' �����#
. 

 

    	�
 Command Window �
� Matlab �����
����: 

>> p1=-2+2·j 

>> p2= conj(p1) 

>> poly([p1 p2]) 

 

!
 ��
������� ����� ans=[1 4 8], 
�'�� 
 �������
���� �
� ����
�������

" 

�
����"�
� �����: 

8  s4  s
2 ���  

 

 %�

�����
� �
 	.�.$.5 �����
"� ��'�
� �� ����� �"�
� 1, #���#� �� ��
��� �� 

�

�
������ - �� ����������
 � ���� ���� �'���� 
�������� - 
�� ���
#
 ��� 
��� 

����������, ������ �
 
��#
� �'����� 
��������� �ss �� ��
"��� �� 1, ������� 
 

���������  ������ �� ��
"��� �� �
� ������' '�
 �
� �����
�����: 

� �
bsas

b
sH

2 ���
�   1��

b

b
K ss  . 

 

	������, � ��������� ���� 
��� �
� ��
#"���
� 	.�.$.5 �����
"� ��'�
� �����:   

 � �
84

8
2 ���

�
ss

sH  (14) 

 ��� �� #��
���
�
���� �
� 	.�.$.5. ���������� � ����
�� 
��������� ����'#
� 

#������
��(��� �s. H ��
��
� ������� �
� ��������
� ��
"��� ��:   

5.0
2

1

)(

1
���

ipreal
�  (sec) 

H ����
#
� #������
��(��� ���������� �� �6��:  
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� � � �25.005.05.01.0 ����� ss TT ��  


�� ����
� ���������� �� ����
#
� #������
��(��� � ����: 

005.0�sT  (sec) 

 

	�
 command window �
� Matlab �����
����: 

>> H=tf(8,[1 4 8])  

>> Hz=c2d(H,0.005) 

 


�� � #��
���� ��������� ���� 
��� �
� (� ��

" 	.�.$.5. ����� 

 � �
9802.09800.1

109867.0109933.0
2

44

���
����

�
��

zz

z
zH   (15) 

 � ��������� ���� 
��� �
� #��
���
" 
��������� Gc(z) ��
�
��*���� ��' ��� 

�6����� (10). ��� �
 �'�
 ���', ��
 command window �
� 0atlab �����
����: 
 

>>Gps=tf(2846.5299,[1 21.6612 117.3019]) 

>>Gpz=c2d(Gps,0.005) 

  

 H #��
���
�
������ ��������� ���� 
��� �
� 
������� Gp(z) �
� ��

"���� �����:  

 � �
8974.08946.1

0331.00343.0
2 ���

��
�

zz

z
zGp  (16) 

 

>> [nP,dP]=tfdata(Gpz,'v'); 

>> [nH,dH]=tfdata(Hz,'v'); 

>> format long; 

>> Gcz=tf(conv(nH,dP),conv(nP,(dH-nH)),0.005) 


�� 
 #��
���'� 
���������� �
� �� ������
�
����� ���� ��������� ���� 
���:  

 

 � �
03240031900348003430

88540978008952099330
101

234

234
4

.z.z.z.z

.z.z.z.z
zGC �������

�������
��� �  (17) 

 

3.4 
��
����� ��
 �
�������� �� ������ �������� 

������� 
 

) 
" ���� ��
�
������ � ��������� ���� 
��� �
� ����
��
� 
���������, ��
��� 

���
� �� ��
�
����� �
 .� ��
' 	.�.$.5. 	��� ���� ���#��*���� 
�� �������������� �
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.� ��
' 	.�.$.5. ��
 Simulink �
� MATLAB, ��� ��� �������� ��
�
������ �
 

�������� ! .� ��
' 	.�.$.5. �"����� �������������
���
� �
� 
������� 
�� ��� 


����� ����
��� #�#
����� (DAQ).  

	�
 	���� 3.11 ���
����*���� �
 (� ��
' �"����� �����
� 
�����
" ��'��
� �� 

���
#
 �
��#���� �����#� �
 
�
�
 ���� ���������� 
�������� ��� ��
�
�
���� ��
 

simulink �
� MATLAB. 

 

 

	���� 3.11 : 0
����
 �6
�
����� �
� .� ��

" ��������
� �����
� 
�����
" ��'��
� ��   

���
#
 ��� 
��� �����#� (step). 

 

!
 #
��
' ��
����
 “Discrete transfer Fcn1”, ������� �� ��������� ���� 
��� �
� 

#��
���
" 
��������� Gc(z) �
� ��
�
�����
� ��
��
"����. 	��� ��������
�� �
� #
��

" 

��
����
� �����
���� 
� ����������� ��� �
����"��� ��� ���������� ���� 
���:  

Numerator coefficient: 1.0e-004· [0.9933  -0.9140  -0.9788   0.9032] 

Denominator coefficient: [0.0233  -0.0235  -0.0220   0.0222] 

Sample time: 0.005 

  

T
 #
��
' ��
����
 “Transfer Fcn” ������
����"�� �� ��������� ���� 
��� 

�����
"� ��'�
�� �
� 
�������:  
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 � �
3019.1176612.21

5299.2846
2 ���

�
ss

sGp  (18) 

 

�������, ���� ��������
�� �
� �����
����: 

Numerator coefficient: 2846.5299 

Denominator coefficient: [1  21.6612  117.3019] 

 

!
 “zero-Order Hold” ������� �
� ������
��� ��' #��
���' ���� �� ���� �����
"� 

��'�
� (DAC) 
�� ���������� ��� �6
#
 �
� #��
���
" 
��������� �� ���� �����
"� 

��'�
� �
� “
#����” �
� 
�������. 	��� ��������
 ‘sample time’ �
� block ��������� � 

���� 0.005, �
" ������
����"�� ��� ����
#
 #������
��(���. 

!
 “Step” ������� ��� ���
#
 ��� 
��� �����#� ��
� �
 	.�.$.5. 
�� ���� 

��������
�� �����
����:  

step time:0 

Initial value:0 

 Final value: 170 

 Sample time: 0.005   

�����*
���� 
� ��������
�  ��
 ��#�
: 

Simulation- Configuration Parameters –Simulation time-> 

Start time:0 

Stop time:20 

Sample time:0.005  


�� �������� �
 “Start simulation” 6�
����� � ��
�
�
����.  

	�� �������� ��
�
������ �
 ��������
' �"�����. 	�
 	���� 3.13 ���
����*���� � 


�

�������� ���#���
�
��� �
� .� ��

" 	.�.$.5. � �6
#
� 
�� � ��
 
#
��� �
� 

���������
� �������� �����
�� ���"����� ���#�
���� ���� ���
#
 Fin 
�� Vcc-opto 

������
��� �
� ������
��� ����'����� �� ����. 	��� ��������, � �6
#
� Vout �
� 

������
��� 
#������� ���� ���
#
 Analog Input Channel 0 ��� 
����� ����
��� #�#
����� 

DAQ ���  pin 68+/67- ��� ���
���� #���"�#���� ���'#�� �6'#�� SCB-68. � �6
#
� Analog 

Output Channel 0 (pin 22+ /55-) ��� 
����� DAQ 
#������� ���� ���
#
 Vin �
� �������� 
�� 

���
� 
 ��'��
� �
� ��������
� 
�

��������� �� �� �"�#��� ��� ��
 
#
���� �
� 


������� ���� �6
#
 OUTPUT �
� ��������. 	�
� �������� � ���'*���� ��������
� ���� 
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±16 Volts DC ��� ��
� ������
��� ����'����� �� ���� � ���'*���� ��
 
#
��� 15 Volts 

DC.   

 

 

	���� 3.13: 	��#���
�
��� �
� .� ��

" 	.�.$.5. 

 

0��� ��� 
�

������ ��� ���#���
�
���� '��� ��� ����� �
� ��������
� 

��������� #��
���'� 
���������� ���� �
� Simulink. 	�
 	���� 3.14 ���
����*���� �
 

�
����
 �
� ���� 
����
�������. 	�� ����
� �
� ��
����� ������� � ��������� ���� 
��� 

�
� #��
���
" 
��������� �
� ��
�
�����
� ��
��
"����, ��� ���
� � �������� �� #"
 

#
��
� ��
����� ���'#
�/�6'#
� �� 
�
�� ���#�
�� �
 �
����
 �� ���  ���
�� 

���'#
��/�6'#
�� ��� 
����� ����
��� #�#
�����. 
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	���� 3.14: 0
����
 ��
�
����� .� ��

" �����
� �� ���
#
 ��� 
��� �����#� ����
� 

170 rad/sec 

 

	�
 #
��
' ��
����
 Analog Input �
 
�
�
 ���#����� �� ��� ����
��
� ���
#
 

(ACH0) ��� 
����� DAQ, ���������� � ���� �6'#
� �
� ������
��� ����'����� �� ����, 

� 
�
�� ������������ �� �����
� ���"���� �"� ��� �� �� �����: 

�=64.5650·V-2.5923  

�
� ��
�
�����
� ��� ������� 
 2.3.3. ,�'��:  

$(Gain):[Gain:64.565031,sampletime:0.005]  

C(Constant):[Constant Value:2.592383,sample time:0.005] 

  

+'�� �
� '�� ���� �6
#
 �
� ������
��� ������� ��� offset ���� 0.1 Volts �
'�� 
�� 

'��� 
 
�������� #�� �������� ����, ���� � ���� � �������� �����
���� ��
 �"�����  �
 

#
��
' ��
����
 ‘Constant1’ ��
 
�
�
 ��������� � ���� 0.1. 	�� ��������, � ����
"����  
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�����
� ���"���� �
� 
������� ���
������� �� �� �����
� ���"���� �
� #������ ���� 

���
#
 ��� 
��� 
�� �
 � ���� �
� ��

"���� 
#������� ��
 #��
���' 
��������� ‘Discrete 

Transfer Fcn1’, 
�� � 
" �
 “#�
������”, �
 
#���� ��
 #
��
' ��
����
 ‘zero order holder’ 

�
� �
 ���������� 6��� �� ����
��
' ����. !��
�, ���� �
� #
��

" ��
����
� ‘Analog 

Output’ �
� ���#����� �� ��� ����
��
� �6
#
 (DAC0OUT) ��� 
����� DAQ, � �6
#
� �
� 


��������� 
#������� ���� ���
#
 Vin �
� ����

" ��
����
� �����
� (���������), �
 
�
�
 

����������� ��� �������� ���� �� ���������� � “
#�����” �
� 
�������.  

0� �����
�
������ �
� �������� 
�� �
 ���
 '����
 ���������� (��' �
 menu): 

“Tools-> Realtime Workshop -> Build model” ���� �� ��
�
����� �
 �
����
  ���� 
���� 

����
��� #�#
�����. 	�� �������� “Simulation-> Connect to target” ��� ��� ������6� ��� 

���

������� �
� ��
�������
� �� ��� 
���� ����
��� #�#
����� 
�� ���
� ��' �
 menu 

����������“Simulation -> Start Real-Time Code” ��� �� 6�
������ �� �
�������� �
 

��'������ 
�� � 
������ � ��� ��'
����� �
� 
������� 
�� ��� ���'#
� ��� 
���.  

!��
�, ���
������� � �������
� ��'
���� �
� 	.�.$.5. �� ����� �� ��� ��������
� 

��'
���� 
�� ��� ���
#
 ��� 
���. 	�
 �������
 ���
��� (command window) �
� matlab 

���������:  

>> plot(timeth,inth,’k’,timeth,outth,’r’,t,w,’b’),zoom,grid 


�� ��

"���� �
 	���� 3.15 �
� �

�
����: 
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	���� 3.15: )�'
���� �������

" 
�� ��������

" ��������
� �����
�: ;;; ���
#
� 
��� 
��� , ;;; ��'
���� �������

" ��������
�, ;;; ��'
���� ��������

" 

..	.�.$.5. 
 
 
 
3.5 
��
����� ��
 �
�������� �� ������ �������� 

���������� 

 
	�� �������� ��
�
������ �
 .� ��
' 	.�.$.5.  �� ���
#
 ��� 
��� ���������� 

(ramp). 	�
 	���� 3.16 ���
����*���� �
 �
����
 ��
�
�
����� �
� (������
�
����
� 

��
��
"����) ����*
���� ��� ���
#
 ��� 
��� �����#�� (step) �� ���������� (ramp).      
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	���� 3.16 0
����
 �6
�
����� �
� .� ��

" ��������
� �����
� 
�����
" ��'��
� ��   

���
#
 ��� 
��� ���������� (ramp). 

 

��� ��� ������6� �����
�� ���"����� �
� 
������� ���� ���� 170 rad/sec �� ��'�
 10 

sec ������
�, ���� ��������
�� �
� #
��

" ��
����
� ‘Ramp’ �����
����:  

Slope:17 

 Start time:1 

Initial output:0 

1����*
���� 
� ��������
�  ��
 ��#�
: 

 Simulation- Configuration Parameters -Simulation time-> 

 Start time:0 , Stop time:10 ,Sample time:0.005 


�� �������� �
 “Start simulation” 6�
����� � ��
�
�
����. 	�� �������� ��
�
������ �
 

��������
' �"�����. 	�
 ����� 3.17 ���
����*���� �
 �
����
 �� ���
#
 ��� 
��� �"�
� 

����������. 
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	���� 3.17: 0
����
 ��
�
����� .� ��

" �����
� �� ���
#
 ��� 
��� ����������� 


����� 17. 

 

9�� �� ��'�
��� #
��
� ��
����� �������
�� �� �#�� �� ��� ��
��
"����� 

��
�
����� (���
#
� ��� 
��� �����#�). 0� �����
�
������ �
� �������� 
�� �
 

���
 '����
 ���������� (��' �
 menu): “Tools-> Realtime Workshop -> Build model” ���� 

�� ��
�
����� �
 �
����
  ���� 
���� ����
��� #�#
�����  ��� �������� “Simulation-> 

Connect to target” ��� ��� ������6� ��� ���

������� �
� ��
�������
� �� ��� 
���� 

����
��� #�#
����� 
�� ���
� ��' �
 menu 6��� “Simulation -> Start Real-Time Code” ��� 

�� 6�
������ �� �
�������� �
 ��'������ 
�� � 
������ � ��� ��'
����� �
� 
������� 
�� 

��� ���'#
� ��� 
���. ��� �� �"�
���� �������
�� 
�� ��������
�� ��'
�����, ��
 

�������
 ���
���   (command window) �
� matlab ���������:  

>> plot(timeth,inth,’k’,timeth,outth,’r’,t,w,’b’),zoom,grid 


��  ��

"���� �
 	���� 3.18. 
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	���� 3.18: )�'
���� �������

" 
�� ��������

" ��������
� �����
�: ;;; ���
#
� 
��� 
��� , ;;; ��'
���� �������

" ��������
�, ;;; ��'
���� ��������

" 

..	.�.$.5. 
 

 

3.6 
��
����� ��
 �
�������� �� �
������� ������ 

�������� 

 

 	��� ������� 
 ����, ���
����*
���� �� ��
��������� ��
�
�
����� �
� 

�������

" 	.�.$.5. 
�� ��� ��'
����� �
� ��������

" .� ��

" 	.�.$.5. �� 

������
��
� ���
#
 �
� �������� ������� �����#��, �����������,  
�� � ����
�
��#
"� 

���'#
�. )���
� #���
���
"���� ��
 Matlab �
 #������� ��'�
�-���'#
� �� ��� ����
��� 

���
���: 

 

>> x1=zeros(1000,1);     

>> x2=170*ones(1000,1);   

>> x3=linspace(170,50,1000)';  

>> x4=linspace(50,170,1000)';  
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>> x5=170+50*sin(2*linspace(0,5,2000))';        

>> x6=linspace(x5(end),0,2000)';   

>> t=linspace(0,40,8000)';  

>> inp= [x1; x2; x3; x4; x5; x6;]; 

>> arbin=[t inp];  

 

	�
 ����� 3.19 ���
����*���� �
 �
����
 ��
�
�
����� �
� 	.�.$.5. �� ��� ���
#
 

��� 
��� "arbin. 

 

 

	���� 3.19: 0
����
 �6
�
����� �
� .� ��

" ��������
� �����
� 
�����
" ��'��
� ��   

������
��
� ���
#
 ��� 
��� . 

 

	�
 #
��
' ��
����
 “arbin” �����
���� 
� ��������
� ��� ��#��: 

Data: arbin 

Sample time: 0.005 

�����*
���� 
� ��������
�  ��
 ��#�
: 

 Simulation- Configuration Parameters –Simulation time-> 

 Start time:0 , Stop time:40 ,Sample time:0.005  


�� �������� �
 “Start simulation” 6�
����� � ��
�
�
����. 	�� �������� ��
�
������ �
 

��������
' �"�����. 	�
 	���� 3.20 ���
����*���� �
 �
����
 �� ��� “���������” 

(arbitrary) ���
#
 ��� 
��� �
� ���� 
����
�������. 
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	���� 3.20: 0
����
 ��
�
����� .� ��

" �����
� �� ������
��
� ���
#
 ��� 
���. 

 

0� �����
�
������ �
� �������� 
�� �
 ���
 '����
 ���������� (��' �
 menu): 

“Tools-> Realtime Workshop -> Build model” ���� �� ��
�
����� �
 �
����
 ���� 
���� 

����
��� #�#
����� ��� �������� “Simulation-> Connect to target” ��� ��� ������6� ��� 

���

������� �
� ��
�������
� �� ��� 
���� ����
��� #�#
����� 
�� ���
� ��' �
 menu 

6��� “Simulation -> Start Real-Time Code” ��� �� 6�
������ �� �
�������� �
 ��'������ 


�� � 
������ � ��� ��'
����� �
� 
������� 
�� ��� ���'#
� ��� 
���. ��� �� �"�
���� 

�������
�� 
�� ��������
�� ��'
����� ��
 �������
 ���
��� (command window) �
� 

matlab ���������:  

>>plot(timeth,inth,’k’,timeth,outth,’r’,t,w,’b’,),zoom,grid 


�� ��

"���� �
 	���� 3.21. 

 



$��)+)�, 3 
 

 49 

 

	���� 3.21: )�'
���� �������

" 
�� ��������

" ��������
� �����
�: ;;; ���
#
� 

��� 
��� , ;;; ��'
���� �������

" ��������
�, ;;; ��'
���� ��������

" 

..	.�.$.5. 
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	������� 4 

�
�
�������� 

 

 	��� ���
"�� ������� ���#�����
� 
�� ��
�
����
� ��� (� ��
' �"����� �����
� 

��� ��� �"����� ��� �����
�� ���"����� ��'� 
������� �����
"� ��"���
� (D.C.) �� �� 

����� ���
��
��

"  ��
�
�����. 	�� ������� ��� ��������, ����
� ����� 
 ���#����'� 
�� 

� 
����
���  ��� #�� '��� �����#�� ��' ��� 
�
��� ��
�������� �
 �"�����, ��
� 


��������, ���
 '����
, ��������� 
�� ��� �������� � �"�#��� �
� ��������
� �� ��� 


���� ����
��� #�#
����� 
���� 
�� 
 ��
����������'� ����� �� ����� �
� �
�����

" 

Matlab.  

 !
 �"����� ����
"����� ����� ��
������� ���������
����� �� �����
 ����' �
� 

��'�
 �
� ����
� ���  ��� �
� ���#����
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